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1. Lwu y quan trong

S tay str dung dién ttr nay danh cho moi
ngwdi dung st dung man hinh Philips.
Hay danh thoi gian doc sb tay st dung
nay trwdc khi st dung man hinh. Sé tay
bao gébm nhirng théng tin va cac luu y
quan trong lién quan dén viéc st dung
man hinh.

Ché dd bao hanh cta Philips ap dung v&i
diéu kién la san phdm phéi dwoc st dung
ding cach theo muc dich st dung, theo
cac hwéng dan hoat dong cling véi viéc
xuét trinh hoa don gbc hodc bién nhan
tién mat ghi ré ngay mua, tén nguwoi ban,
mau ma va ma sb6 san xuét clia san pham.

1.1 Lwu y an toan va bao dwéng

) Canh bao

S dung cac nut diéu khién, diéu chinh
hoac cac quy trinh khac ngoai cac quy
trinh dwoc néu ré trong tai liéu nay cé thé
khién nguwoi dung dé bi dién giat, gap cac
rai ro vé dién va/hodc co hoc.

Hay doc va thwce hién theo cac hwéng dan
sau khi két ndi va str dung man hinh may
tinh.

Hoat dong

« Hay dat man hinh & khu vyc khéng cé
anh sang trwe tiép ctia mét, anh sang
ric c6 cwong d6 manh va cach xa
b4t ky ngudn nhiét nao khac. D&t man
hinh l1au ngay trong moi tredng nay co
thé khién cho man hinh bj bac mau va
héng.

+ Di chuyén moi d vat c6 thé roi vao
céac 16 théng gié ctia man hinh hoac
ngan can qua trinh lam mat thich hop
cla céc thiét bj dién t&r bén trong man
hinh.

+ Khoéng bit kin cac 16 théng gié trén vé
man hinh.

Dam bao d&t man hinh & gan noi c6
phich c&m va & cdm dién.

Néu tat man hinh bang cach rut cap
ngudn ho&c day dién DC, hay doi 6
giay trwéc khi cdm cap ngudn hodc
day dién DC dé man hinh hoat dong
binh thuwong.

Hay luén dung cap ngudn chuan dugc
cép bai Philips. Néu thiéu cap ngudn,
hay lién hé v&i trung tdm dich vu tai
dia phwong ban. (Vui long tham khao
muc Trung tam thong tin tiéu dung
cham séc khach hang)

Khong dat man hinh & noi bi chén
ddng hay va cham manh khi dang
hoat déng.

Khéng dap hoac lam roi man hinh khi
dang hoat dong hoac khi di chuyén.

Bao dwdng

D& man hinh khéng bi hdng, khéng dé
nén qua manh Ién mat man hinh LCD.
Khi di chuy&n man hinh, hay ndm chat
khung man hinh d& nhéc Ién; khong
nhéc man hinh bdng cach dat ban tay
hodc ngén tay Ién mat man hinh LCD.
Rt phich cdm man hinh néu ban
khéng dinh st dung no trong thdi gian
dai.

Rut phich cdm man hinh néu ban can
lau chuii man hinh bdng mét miéng

vai hoi wét. Ban cé thé lau man hinh
b&ng vai kho khi da ngat dién. Tuy
nhién, dwng bao gi¢ dung dung moi
hiru co, chang han nhu con hoac cac
chét 16ng c6 ngudn gbc tr amoniac dé
lau man hinh.

D& tranh nguy co bj dién giat hodc
hdéng vinh vién bé man hinh, khéng
dat man hinh & noi ¢d bui, mwa, nwdc
ho&c & noi qua am wot.

Néu man hinh bj wét, hay lau né bang
vai kho cang sém cang tot.

Néu chét la hodc nwdc dinh vao man
hinh, hay ngét dién ngay va rat cap
ngudn. Sau d6 lau sach chét la hodc



nwéce rdi glri man hinh dén trung tam
bdo duwéng.

Khoéng cét giv hodc st dung man hinh
& noi ¢6 ngudn nhiét, &nh nang trwc
tiép hodc qua lanh.

D& duy tri hoat dong téi wu cia man
hinh va st dung né trong thoi gian dai,
hay dung man hinh & noi nam trong
gi6i han nhiét dd va d6 4m sau.

« Nhiét d6: 0-40°C 32-95°F

« D6 a&m: 20-80% RH

LUU Y: Ludn bat trinh bdo vé man
hinh chuyén déng khi ban khéng st
dung man hinh. Luén bat &vng dung
lam m&i man hinh dinh ky, néu khoéng,
man hinh ctia ban sé& hién thi nhitng
ndi dung tinh khong thay dbi. Hién thj
lién tuc cac anh tinh trong moét thoi
gian dai c6 thé gay ra hién twong “anh
thtr néng”, con dwoc goi la “anh ao”
hay “anh bong ma”, trén man hinh cla
ban.

“Anh thir néng”, “Anh a0” hay “Anh
béng ma” la hién twong phd bién trong
céng nghé man hinh LCD. Trong hau
hét cac trwong hop, hién twong “anh
thtr ndng” hodc “anh 40" hay “anh
béng ma” sé& dan dan bién mét sau
mot thdi gian man hinh bi ngét dién.

) Canh bao

Khéng thé kich hoat trinh bdo vé man hinh
hoac &rng dung nap lai man hinh dinh ky
c6 thé gay ra cac sy cb nghiém trong nhuw
“thtr néng” hodc “anh sau” hoac “anh boéng
ma” von sé& khong biét méat va ciing khong
thé khac phuc. Thiét hai nhw trén khéng
nam trong chinh sach bao hanh ctia ching

toi.

Dich vu

Chi nhan vién dich vu chuyén mén
m¢&i dwoc mé vo boc man hinh.
Néu can moi tai liéu hwéng dan dé
stra chira hodc tich hgp man hinh,
hay lién hé v&i trung tdm dich vu tai

dia phwong ban. (vui long tham khao
chwong "Trung tdm théng tin tiéu
dung")

+ D& biét thong tin vé viéc van chuyén,
vui ldng tham kh&o muc "Théng sé ky
thuat".

« Khéng dat man hinh trong xe hoi/cép
xe dwdi anh nang truc tiép.

© Ghichu

Hay tham khao y kién clia k¥ thuat vién
dich vu néu man hinh khéng hoat déng
binh thuwd'ng hodc néu ban khéng chac
phai thwc hién quy trinh nao khi da lam

theo cac hwéng dan hoat déng néu trong
soO tay nay.



1.2 M6 ta biéu twong

Céac muc phu sau day md ta cac quy wéc
ve biéu twgng dung trong tai liéu nay.

Ghi chu, Lwu y va Canh bao

Trong toan bd sb tay nay, cac doan chi®
c6 thé di kém biéu twong va dwoc in dam
hodc in nghiéng. Cac doan nay bao gbm
cac ghi chu, lwu y hodc canh bao. Chiung
dwoc str dung nhu sau:

© Ghichu

Biéu twong nay cho biét cac théng tin
quan trong va cac bi quyét gip ban tan
dung tét hé théng may tinh.

OLruy

Biéu twong nay cho biét cac thong tin gitp
ban biét cach tranh dwoc sw cb héng héc
tiém &n déi voi phan cliing hodc mét dir
liéu.

) Canh bao

Biéu twong nay cho biét sy tén thwong
co thé tiém an va gilp ban biét cach tranh
dwoc sw cd do.

M6t s6 canh bao cé thé xuét hién & nhiéu
dinh dang va co thé khong di kém mot
biéu twong. Trong nhirng trwdng hop nay,
cach thire trinh bay cu thé clia canh bao
do dwoc quy dinh bédi co quan chirc nang
lién quan.


http://www.philips.com/about/sustainability/recycling
http://www.philips.com/about/sustainability/recycling

1.3 Disposal of product and packing
material

Waste Electrical and Electronic Equipment-
WEEE

This marking on the product or on its
packaging illustrates that, under European
Directive 2002/96/EC governing used electrical
and electronic appliances, this product may
not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations on
how to dispose of your old monitor and packing
from your sales representative.

Taking back/Recycling Information for
Customers

Philips establishes technically and economically
viable objectives to optimize the environmental
performance of the organization's product,
service and activities.

From the planning, design and production
stages, Philips emphasizes the important of

making products that can easily be recycled. At
Philips, end-of-life management primarily entails
participation in national take-back initiatives

and recycling programs whenever possible,
preferably in cooperation with competitors,
which recycle all materials (products and related
packaging material) in accordance with all
Environmental Laws and taking back program
with the contractor company.

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit

http://www.philips.com/sites/philipsglobal/
about/sustainability/ourenvironment/

productrecydingservices.page




2. Cai dit man hinh Bl Lap chan de

1. D&t man hinh ndm sép trén bé mét
mé&m min, can than dé tranh lam tray
2.1 Lép dat xw&c hodac héng man hinh.

El N6i dung g6i hang

%%art

2. Gilr chan dé man hinh bang ca hai tay
A — va lap chat chan dé vao tru dé.
(1) Gan nhe chan dé vao tru dé cho
dén khi'chét cai khép chat vao
chan de.

(2) Dung ngon tay van chat dinh vit
nam & phia dwdi chan dé va siét
chéat chan dé vao tru dé.

Adapter/—\C/DC .
(dién xoay chieu/mot chieu)

=,
@7 & )
N Cép am thanh
HDMI (t h
(tty chon) (tuy chon)

VGA (tuy chon) DVI (tuy chon)

& Ghichu

Chi nén st dung mau adapter AC/
DC: Philips ADPC1245(227E4 QHAD),
ADPC1236(227E4 LSB/LHSB/LHAB,
227E4 QSD/QHSD)




El Két néi véi PC
Mau 227E4QSD, 227E4LSB:

© Dau vao ngudn dien AC/DC
© Dbiu vao VGA

© Dbau vao DVI-D

O Khéa chbng trém Kensington

Mau 227E4QHAD, 227E4LHAB:

© Dau vao ngudn dien AC/DC
© Dbiu vao VGA

© Dbau vao HDMI

@ bau ra tai nghe

© Diu vao am thanh

@ Khoa chbng trom Kensington

MAu 227E4QHSD, 227E4LHSB:

© Dau vao ngudn dien AC/DC
© Diu vao VGA

© Dau vao HDMI

O Diu ra am thanh HDMI

© Khéa chdng trém Kensington

Két néi véi PC

1.

w N

Cam chét cap ngudn vao mat sau cla
man hinh.

Tat may tinh va rat cap ngudn.

Cam cap tin hiéu man hinh vao 16 cdm
video & mat sau may tinh.

Cam cap ngudn clia may tinh va cap
nguén clia man hinh vao 6 cam dién
gan do.

5. Bat may tinh va man hinh. Néu man

hinh hién thi hinh &nh thi qua trinh cai
dat da hoan tat.



2.2 Str dung man hinh

E M6 ta mat trwéc cha san pham

Mau 227E4QSD, 227E4LSB,
227E4QHSD, 227E4LHSB:

PHILIPS

M&u 227E4QHAD, 227E4LHAB:

PHILIPS

A

Ep/v ©/A 10/ /0K [0)

I I [\ I
(7] 6 060 o (1)

(54

BAT va TAT ngudn man

BD/v /A 0/4 /0K [0) (1) Q) X
| |\ | hinh.
o 6 ©6 e o ® &)/0K|Truy nhap menu OSD.
o - |BAT va TAT ngudn man ©® d |[Trévé mirc OSD trwoec.
O Ihinh. O | ¢ [Chinham lvong loa.
® ©)/OK Truy nhap menu OSD. © | A V¥V Chinh menu OSD.
© <« |Trdvé mic OSD truoc. O | -© Bdingudn vao tin higu.
O | [ |Déidinh dang hién thi. Smartimage Lite. C6 ba
Chinh menu OSD. ché d6 dé ban Iwa chon:
©OlAV o @ Standard (Chuéan), Internet,
O ©® |Ddingudn vao tin hiéu. Game.
Smartlmage Lite. C6 ba
ché do dé ban lwa chon:
o @ Standard (Chuén), Internet,
Game.




F1 M6 ta menu Hién thij trén man hinh
Hién thi trén man hinh (OSD) la gi?
Hién thi trén man hinh (OSD) la mét tinh
nang c6é & moi man hinh LCD cua Philips.
N6 cho phép ngudi dung diéu chinh hoat
déng cta man hinh hodc chon cac chire
nang ctia man hinh tryc tiép théng qua
mot clra sd huwéng dan hién thi trén man
hinh. Mét giao dién hién thij trén man hinh
dé st dung duoc thé hién nhw sau:

M&u 227E4QSD, 227E4LSB:

anguage

Hwéng dan co ban va don gian vé cac
nat diéu khién

Trong menu OSD minh hoa & trén, ban co
thé nhan v A cac nat & g& mét truée cla
man hinh dé di chuyén con tré va nhan nat
OK dé& xac nhan lwa chon hodc thay déi.

Menu OSD

Dwéi day la tbng quan vé co clu cla
menu Hién thi trén man hinh. Ban cé thé
st dung co cAu nay lam théng tin tham
khao khi muén thwe hién cac diéu chinh
khac sau nay.

Main menu Sub menu

— Input — VGA

— DVI (available for selective models)

—— HDMI (available for selective models)

+— Picture r— Picture Format —— Wide Screen, 4:3
— Brightness — 0~100
— Contrast — 0~100
— SmartResponse —— Off, Fast, Faster, Fastest
(available for selective models)
t— SmartContrast — On, Off
+— Pixel Orbiting — On, Off
L— Over Sacn — On, Off
(available for selective models)
— Audio — Volume — 0-100
(available for selective models)
— Stand-Alone — On, Off
— Mute — On, Off
+— Color r— Color Temperature ~— 6500K, 9300K.
— sRGB
—— User Define Red: 0~100
E Green: 0~100
Blue: 0~100
— Language — English, Espafiol, Frangais, Deutsch, Italiano,

Portugués, Pycckuin, fE#KH3Z, Tiirkge

—— OSD Settings — Horizontal — 0~100
— Vertical — 0~100
— Transparency — Off,1,2,3,4
— OSD Time Out — 5s, 10s, 20s, 30s, 60s
L— Setup — Auto
— H.Position — 0~100
— V.Position — 0~100
— Phase — 0~100
— Clock — 0~100
— Resolution Notification — On, Off
— Reset — Yes,No
L Information




El Théng bao vé dé phan giai

Man hinh nay dwoc thiét ké dé& hoat
dong téi wu véi do phan giai gbe la
1920%x1080@60Hz. Khi dwgc chinh sang
dd phan giai khac, man hinh sé hién thi
mét théng bao: Use 1920x1080@60Hz
for best results. (Hay dung d6 phan giai
1920%x1080@60Hz dé co6 két qua téi wu.)

Ban co thé tat thong bao hién thi 46 phan
gidi goc tir myc Cai dat trong menu OSD
(Hién thi trén man hinh).

B Tinh nang vat ly
Nghiéng




3. Té6i wu hoa hinh anh

3.1 Smartlmage Lite

E b6 lagi?

Smartlmage Lite cung clp cac chirc ndng
cai d&t san gitp ban t6i wu hda man hinh
d& str dung cho céc kiéu ndi dung khac
nhau, linh hoat chinh d6 sang, dé twong
phan, mau sic va do sic nét khi st dung
thwe té. DU lam viéc vdi cac tng dung
bang chi, hién thi hinh anh hay xem
video, Philips Smartimage Lite cling mang
lai cho ban hiéu qua man hinh t&i wu nhét.

El Sao t6i phai can n6?

Ban mudn mdt man hinh hién thj téi wu
moi kiéu néi dung wa thich, phdn mém
Smartimage Lite sé linh hoat chinh do
sang, do twong phan, mau sac va do sac
nét khi st dung thwc t& nhdm nang cao
trai nghiém xem man hinh cda ban.

El Cach hoat déng?

Smartlmage Lite la cong nghé déc quyén
tién tién cta Philips vdn sé phan tich cac
ndi dung hi&n thi trém man hinh cla ban.
Dwa trén bdi canh str dung ma ban lya
chon, Smartimage Lite sé linh hoat cai tién
do twong phan, bao hoa mau séc va do
s&c nét clia hinh anh dé cai thién noi dung
dang hién thi - tat ca khi st dung thuc té
chi v&i duy nhat mét cd nhan nat.

Ed Cach bat chire nang Smartimage Lite?

1. Nhén B dé khai dong Smartimage
Lite trén man hinh;
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2. Tiép tuc nhan B dé chuyén gitra
Standard (Chuén), Internet, Game.

3. Menu OSD Smartimage Lite s& van
hién thj trén man hinh trong 5 giay
hoac ban ciing cé thé nhan OK dé xac
nhan lwa chon.

4. Khi Smartimage Lite da duwoc bat, bd
cuc sRGB sé tw dong tat. D& dung
sRGB, ban phal tat Smartlmage Lite
bang nat e g& mat trwdc clla man
hinh.

Néu khong dung nat @) dé cuodn xuong,
ban cling co thé nhan cac nut v a dé chon
va nhan nut OK dé& xac nhan lwa chon va
doéng menu OSD Smartimage Lite.

C6 ba ché do dé ban Iwa chon: Standard
(Chuan), Internet va Game.

@ SmartImage™

Standard

Internet

Game

* Standard (Chuan) Lam rd chir va
gidm do6 sang giup ban dé& doc chi va
bot moi mat. Che do nay tang dang ké
sy ro rang clia ndi dung chi¥ va hiéu
suét khi ban lam viéc vai cac béng
tinh, file PDF, cac bai muc scan hoac
cac trng dung van phong khac noi
chung.

e Internet: Cau hinh nay két hop bao
hoa mau sac, linh hoat tang do twong
phan va sac nét dé hién thj anh chup
va cac hinh anh khac véi dd ré noi bat
cling mau séc sbng dong - tat c& moi
thir ma khong hé co dau vét ctia mau
sac nhat va gia tao.

» Game: Tang mach truyén dong dé co
thdi gian dap tng toi wu, gidam cac
bo 1€ gai goc cho cac doi twong di
chuyén nhanh trén man hinh, tang do
twong phan cho bd cuc sang va toi,
cau hinh nay mang lai cho nguw&i choi
trai nghiém choi game tét nhét.



3.2 SmartContrast

K Do lagi?

Céng nghé ddc dao von linh hoat phan
tich néi dung hién thi va tw dong toi wu
hoéa ty lé twong phan cta man hinh LCD
dé mang lai d6 ré nét va trai nghiém xem
ti wu, tang mirc dén nén dé hién thi
nhirng hinh anh sang ré hon, sac nét hon
va song dong hon hay gidm mirc dén nén
@& hién thi rd hinh anh trén phong nén ti.

El Sao t6i phai can n6?

Ban mudn hién thi ndi dung rd nét cung
cam giac thodi mai nhat khi xem moi loai
ndi dung. SmartContrast sé linh hoat chlnh
do twong phan va mirc dén nén dé hién
thi nhirng hinh anh choi game hay video
cwc rd, song dong va sac nét hay hién thi
ndi dung chi r6 rang dé doc cho cac rng
dung van phong. Bang cach glam viéc tieu
thu dién ctia man hinh, ban sé tiét kiém
duoc chi phi nang Iwcmg va kéo dai tudi
tho cho man hinh ctia ban.

El Cach hoat déng?

Khi ban bat ché d6 SmartContrast, n6 sé
phan tich ndi dung dang hién thj trong
thwe té dé chinh mau sac va mat dé den
nén. Chirc nang nay sé linh hoat tang
do twong phan dé mang lai cho ban trai
nghiém giai tri tuyét v&i khi xem video
hoac choi game.

3.3 Philips SmartControl Lite

Phan mém SmartControl Lite mé&i cta
Phillips cho phép ban diéu khién man hinh
qua giao dién do hoa &o tién dung. Cac
diéu chinh phtrc tap la nhirng gi thudc vé
qua kh& vi phdn mém than thién véi nguoi
dung nay sé huéng dan ban qua viéc tay
chinh dé phan giéi, hiéu chinh mau, dieu
chinh déng hd/géc pha, didu chinh diém
trdng RGB (Pd-Luc-Lam), v.v..

Trang bi cdng nghé méi nhat vé thuat toan
I6i xt ly va phén (ng nhanh, phan mém
chay bang anh déng bat méat thwong thich
vé&i Windows 7 ndy san sang nang cao trai
nghiém ctia ban vé&i man hinh Philips!

II Cai dat
Thuwc hién theo chi dan va hoan tat
quy trinh Qal dat. . .

* Ban co6 thé khéi dong phan mem sau
khi hoan tat cai dat.

« Néu mubdn kh&i dong sau, ban cé thé
click ph|m t4t phan mém frén man
hinh nén hodc thanh céng cu may

tinh.

Thuat si khéi dong lan dau

« Lan dau khi cai d&t phan mém
SmartControl Lite, n6 sé tw dong vao
Thuét sT khéi dong lan dau.

* Thuét sT nay sé huwong dan ban thong
qua viéc diéu chinh tirng bwdc vé hiéu
suat man hinh.

+ Sau nay ban cling c6 th& vao menu
Plug-in (B4 sung) dé bat thuat si.

«  Ban c6 thé chinh cac tiy chon khac
qua giao dién Standard (Chuan) ma
khéng can thuat si.



El Khéi dong bang giao Standard (dién

Chuén):

Menu Adjust (Diéu chinh):

Menu Adjust (Diéu chinh) cho phép
ban chinh Brightness (D6 sang),
Contrast (B¢ twong phan), Focus
(Trong tédm), Position (Vi tri) va
Resolution (D6 phan giai).

Ban cé thé lam theo chi dan va thuc
hién diéu chinh.

Lénh Cancel (HUy) sé héi nguwdi dung
xem ho ¢6 mudn hay tién trinh cai dat
hay khong.
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Menu Color (Mau):

* Menu Color (Mau) cho phép ban chinh
mau RGB (Bé-Luc-Lam), Black Level
(Do t6i), White Point (Biém tréng),
Color Calibration (Hiéu chinh mau) va
Smartimage Lite (Vui long tham khao
muc Smartimage Lite).

« Ban co thé 1am theo chi dan va thuc
hién diéu chinh.

* Tham thao bang bén dudi dé hinh
dung co ban vé muc menu phu trén
théng tin nhap cua ban.

e Vidu Qolor Calibration (Hiéu chinh
mau sac):

1. "Show Me" (Cho t6i xem) sé bat
hwéng dan hiéu chinh mau.

2. Start (B4t dau) - bat diu quy trinh
canh chinh mau qua 6 buwéc.

3. Quick View (Xem nhanh) tai cac hinh
anh trwdc/sau.

4. Tré vé giao dién chinh Color (Mau),
click nut Cancel (Huy).

5. Enable color calibration (Bat hiéu
chinh mau) - theo mac dinh la dwgc
bat. Néu khéng chon muc nay, ban
khéng dwoc phép hiéu chinh mau va
tat cac nut khéi ddong va xem nhanh.

6. Phai c6 thong tin bang sang ché trén
man hinh hiéu chinh.
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Man hinh hiéu chinh mau dau tién:

« Nut Previous (Truwéc) sé tat cho dén
khi man hinh mau th& hai bat 1én.

* Next (Ké tiép) s& chuyén vao muyc tiéu
tiep theo (6 muc tiéu).

« K& tiép cudi cuing sé& vao giao dién
File>Presets (File>Cai san).

* Nut Cancel (Hly) sé dc')ng giao dién
nguwoi dung (Ul) va tré vé trang Plug-
in (bb sung).

Smartimage Lite

Cho phép nguoi dung thay ddi cai dat dé

dat mrc cai d&t man hinh tét hon dwa vao

ndi dung.

Khi da cai dat Entertainment (Giai tri), tinh

néng SmartContrast va SmartResponse

sé tat.
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Options>Preferences (Tuy chon>Uu tién)
- Sé chi hoat dong khi chon Preferences
(Wu tién) tr menu Options (Tuy chon) sb
xudng. Trén man hinh khéng hé tro' twong
thich véi chudn DDC/CI, chi cé sén cac
thé Help (Tro giup) va Options (Tuy chon).

« Hién thi cac cai dat wu tién hién hanh.

« O vira chon sé& bat tinh nang nay. O
chon la nat bat/tat.

» Enable Context Menu (Menu bat thudc
tinh) trén man hinh nén PC sé duoc
chon la (Bat) theo mac dinh. Menu
Enable Context (Bat thudc tinh) hién
thi cac lwa chon SmartControl Lite cho
Select Preset (Chon cai sén) va Tune
Display (Chinh man hinh) trong menu
thudc tinh khi click phai vao man
hinh nén. Disabled (D3 tét) s& xéa
SmartControl Lite khdi menu thudc
tinh click phai.

+ Biéu twong Enable Task Tray (Bat
khay tac vu) dwoc chon la (Bat) theo
mac dinh. Enable Context Menu
(Menu bat thudc tinh) hién thi menu
khay tac vu cho SmartControl Lite.
Click phai vao biéu twong khay tac
vu sé hién thi cac tuy chon menu cho
Help (Tro giup), Technical Support
(H6 tro’ ky thuat), Check for Update
(Kiém tra cap nhat), About (V&) va Exit
(Thoat). Khi d& tat Enable task tray



menu (Menu bat khay tac vu), biéu
twong khay tac vu sé chi hién thi EXIT
(THOAT).

e Theo mac dinh Run at Startup (Chay
khi khé&i dong) sé dwoc chon la (BAT).
Khi da tat, SmartControl Lite sé khong
bat khi khéi dong hodc ndm trong
khay tac vu. Cach duy nhat dé bat
SmartControl Lite 1a ttr phim tét trén
man hinh nén hoéc ti file chuwong
trinh. Bat ky bo cai dat sdn nao dé
chay khi kh&i dong sé hoat déng
khéng tai khi 6 nay khong dwogc chon
(Da tat).

+ Enable transparency mode (Bat ché
dd trong subt) (Windows 7, Vista, XP).
Mac dinh Ia 0% Mo.

Options>Input (Tuy chon>Nhap) - Sé chi

hoat ddng khi chon Input (Nhap) tr menu

Options (Tuy chon) s6 xuéng. Trén man

hinh khéng hé trg twong thich véi chuan

DDCI/CI, chi c6 sén céc thé Help (Tro

gitip) va Options (Tuy chon). TAt ca cac

thé SmartControl Lite khac déu khéng co
san.

+ Hién thi giao dién hudng dan Source
(Nguon) va cai dat nguon nhap théng
tin hién hanh.

* Trén cac man hinh nhap riéng, giao
dién nay sé khong hién thj.

Options>Audio (Tuy chon>Am thanh)
- Sé& chi hoat déng khi chon Audio (Am
thanh) tr menu Options (Tuy chon) sb
xubng.

Trén man hinh khéng hé tro twong thich
v&i chudn DDC/CI, chi ¢ s8n cac thé Help
(Tror giup) va Options (Tuy chon).

Help>User Manual (Tro’ gitip>S6 tay stv
dung) - Sé chi hoat dong khi chon User
Manual (Sb tay st dung) t& menu Help
(Tro gitp) s6 xubng. Trén man hinh khéng
hé tro twong thich véi chudn DDC/CI, chi
c6 sén cac thé Help (Tro giup) va Options
(Tay chon).



Help>Version (Tror giup>Phién ban) -

Sé chi hoat dong khi chon Version (Phién
ban) tr menu Help (Tro gitp) sé xubng.
Trén man hinh khéng hé tro' twong thich
véi chudn DDC/CI, chi ¢ s8n cac thé Help
(Tro giup) va Options (Tuy chon).

Context Sensitive menu
(Menu nhay cam vé&i thudc tinh)

Theo mac dinh, menu Context Sensitive
(Chinh theo thuéc tinh) sé& dwoc Bat. Néu
da chon menu Enable Context (Bat thudc
tinh) trong giao dién Options>Preferences
(Tuy chon>Uu tién) thi menu nay sé hién
thi.

The Context Menu (Menu thudc tinh) c6

bon muc nhap:

« SmartControl Lite - khi da chon, About
Screen (V& man hinh) sé hién thj.

* Select Preset (Chon cai dat san)
Cung cAp menu cac muc cai sdn da
Iwu theo trinh tw d& s dung ngay.
Dé&u kiém sé& hién thj muc cai san hién
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da chon. Muc Factory Preset (Cai sdn
gdc) cling 6 thé dugc chon tir menu
s6 xubng.

» Tune Display (Chinh man minh) - M&
bang diéu khién SmartControl Lite.

«  Smartimage Lite - Kiém tra cac cai dat
hién hanh, Standard (Chuén), Internet,
Game.

Pa bat menu khay tac vu

Ban c6 thé hién thi menu khay tac vu
béng cach click phai vao biéu twong
SmartControl Lite tr khay tac vu. Click trai
sé bat rng dung.

Khay tac vu c6 nam muc nhap:

* Help (Tro giup) - Truy cap file User
Manual (S0 tay st dung): M¢& file User
Manual (Sé tay st dung) qua clra sb
trinh duyét mac dinh.

+ Technical Support (H6 trg’ ki thuat) -
hién thj trang ho tro’ ky thuat.

* Check for Update (K|em tra cap nhat)
- dan nguo’l dung dén Nén ung dung
PDI va kiém tra phién ban cla nguoi
dung so voi phién ban c6 san mai
nhat.

+ About (V&) - Hién thj thong tin tham
khao chi tiet: phién ban san pham,
thong tin vé phién ban va tén san
pham.

» Exit (Thoat) - Pong SmartControl Lite.

D& chay lai SmartControl Lite, hdy chon
SmartControl Lite t*r menu Program
(Chwong trinh), click doi biéu twong PC
trén man hinh nén hoac khéi déng lai hé
théng.



PHILIPS

P4 tat menu khay tac vu

Khi da tat Khay tac vu trong thw muc

wu tién, chi con cé san lwa chon EXIT
(THOAT). D& x6a hoan toan SmartControl
Lite khdi khay tac vy, hay t4t Run at
Startup (Chay khi kh&i dong) trong
Options>Preferences (Tuy chon>Uu tién).
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4. Cac théng sé ky thuat

227E4QSD, 227E4QHAD, 227E4QHSD:

Loai mat man hinh Man hinh LCD IPS

Dén nén LED

C& man hinh Réng 21,5 inch (54,6cm)
Heé sb co 16:9

Do pixel 0,248 x 0,248 mm

Do sang 250 cd/m?
SmartContrast 20.000.000:1

Do twong phan (chuan) 1000:1

Thoi gian dap (rng (chuén) 14 ms (mili giay)
Phan (rng théng minh
SmartResponse (chicé san | 7 ms (mili gidy)
cho cac mau da chon)

D6 phan giai toi wu 1920x1080@60Hz

Goc xem 178° (H) / 178° (V) @ C/R > 10
Cai tién hinh anh Smartlmage Lite

Mau man hinh 16,7 triéu mau

Tbc do phat doc 56Hz - 76Hz

Tan sb ngang 30kHz - 83kHz

sRGB (Pé-Luc-Lam chuan) | CO
| Kétnsi ]
227E4QSD: VGA (Analog), DVI (KTS)

227E4QHAD, 227E4QHSD: VGA (Analog), HDMI (KTS)
227E4QHAD : Dau vao am thanh PC, d4u ra tai nghe
227E4QHSD : Bau ra am thanh HDMI

Tin hiéu vao Ddng bo riéng, Bng bd véi tin hiéu xanh luc

DAu vao tin hiéu

DAu ra/vao am thanh

227E4LSB, 227E4LHAB, 227E4LHSB:

Loai mat man hinh Man hinh LCD TFT
Deén nén LED

C& man hinh Réng 21,5 inch (54,6cm)
Hé s6 co 16:9

Do pixel 0,248 x 0,248 mm
Do sang 250 cd/m?
SmartContrast 20.000.000:1

D6 twong phan (chuan) 1000:1

Thoi gian dap (rng (chuén) 5 ms (mili giay)
Phan trng thong minh SmartResponse 2 ms (mili giay)
(chi c6 san cho cac mau da chon)
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.....

1920x1080@60Hz

Goc xem

170° (H) / 160° (V) @ C/R > 10

Cai tién hinh anh

Smartimage Lite

Mau man hinh

16,7 triéu mau

Tbc do6 phat doc

56Hz - 76Hz

Tan sb ngang

30kHz 83kHz

sRGB (Pd-Luc-Lam chuén)

Dau vao tin hiéu

227EA4LSB: VGA (Analog), DVI (KTS)
227E4LHAB, 227E4LHSB: VGA (Analog),
HDMI (KTS)

Dau ra/vao am thanh

227E4LHSB : B4u ra &m thanh HDMI
227E4LHAB : Dau vao am thanh PC, dau ra tai
nghe

Tin hiéu vao

Dong bo riéng, Ddng bd véi tin hiéu xanh luc

Tién ich cho nguw¢i dung

227E4QSD, 227E4LSB, 227E4QHSD, 227E4LHSB:
ED/v /A /< /0K 0]
227E4QHAD, 227E4LHAB:
/v ©/A 10/ 4 /0K 0)

Ngén ngi» OSD (Hién thi
trén man hinh)

Tiéng Anh, Tiéng Phép, Tiéng Brc, Tiéng Tay Ban Nha,
Tiéng Y, Tiéng Nga, Tiéng Hoa Gian thé, Tiéng B Dao
Nha, Tiéng Thé Nhi Ky

Tién ich khéc

Khéa Kensington

Twong thich véi chuan Plug
& Play (Cam vao la phat)

DDC/CI, sRGB, Windows 7/Vista/XP, Mac OSX, Linux

Nghiéng -5° / +20°
227E4QSD:
Ché d6 bat 30,7 W (chuan)
Ché do chd (chuén) 0,5W
T4t (chuan) 0,3W
DPén bao LED ngudn Ché do bat: Ché d6 Trang, Cho/Ngu: Trang (nhap nhay)
B6 nguén Ngoai vi, 100-240VAC, 50-60Hz
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227E4QHAD :

Ché d6 bat 32,1 W (chuén)
Ché dd cho (chuén) 0,5W
Tat (chuén) 0,3W

Dén bao LED ngudn

Ché do bat: Ché do Trang, Chd/Ngu: Trang (nhap nhay)

Bo ngudn

Ngoai vi, 100-240VAC, 50-60Hz

227E4QHSD :
Ché d6 bat 32,1 W (chuén), 38,5 W (t6i da)
Ché d6 cho (chuan) 0,5W
T4t (chuén) 0,3W

Dén bao LED ngudn

Ché do bat: Ché dd Trang, Chd/Ngu: Tréng (nhap nhay)

B& ngudn

Ngoai vi, 100-240VAC, 50-60Hz

227E4LSB:
Ché d6 bat 19,2 W (chuén)
Ché d6 chd (chuén) 0,5W
T4t (chuan) 0,3W

Dén bao LED ngudn

Ché do bat: Ché do Tréng, Chd/Ngu: Trang (nhap nhay)

B& ngudn

Ngoai vi, 100-240VAC, 50-60Hz

227E4LHAB:
Ché d6 bat 19,2 W (chuén), 27,9 W (t6i da)
Ché dd cho (chuén) 0,5W
T4t (chuan) 0,3W

DPén bao LED ngudn

Ché do bat: Ché d6 Trang, Cho/Ngu: Trang (nhap nhay)

B& ngudn

Ngoai vi, 100-240VAC, 50-60Hz

227E4LHSB :
Ché d6 bat 19,2 W (chuén)
Ché dd cho (chuén) 0,5W
T4t (chuan) 0,3W

Deén bao LED nguén

Ché dd bat: Ché dd Trang, Chd/Ngu: Tréng (nhap nhay)

B6 ngudn

Ngoai vi, 100-240VAC, 50-60Hz
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San pham kém theo dé gitr
(Réng x cao x day)

510,0 x 398 x 179 mm

San pham khéng kém theo
dé gi» (Rong x cao x day)

510,0 x 314 x 37 mm

San pham kém theo dé gitv | 2,2 kg
S?n .pzham khéng kem theo 183 kg
dé gitr

San pham déng goi 3,738 kg

binh gitra cac sw cd)

Pham vi nhiét do (hoat dong) | 0°C -40 °C
Gi¢i han nhiét do o °
(Khong hoat dong) UGS EE
D6 &m twong dbi 20% - 80%
MTBF (Thoi lwgng trung 30.000 giov

Chi thi ROHS (Gi¢i han cac

chat gay hai) co
EPEAT Bac (www.epeat.net)
Thung dwng C6 thé tai ché 100%

Cac chat cu thé

Thung dwng 100% khéng chira PVC BFR

Ngbi sao nang lvong

Phé chuén theo quy dinh

Mau

co

CE Mark, FCC Class B, GOST, SEMKO, TCO Certified,
UL/cUL, BSMI, 1S09241-307

Mau den/mau dé tia, hodc cac lwa chon mau khac nhw
ap dung tai khu vie clia ban

L&p son ngoai

Bong lang

& Ghichu

1. Vang hay bac EPEAT chi ¢6 hiéu luc tai noi ma Philips da d&ng ky san pham. Hay truy
cap www.epeat.net dé biét tnh trang d&ng kw tai quéc gia ctia ban.

2. DU liéu nay chiu sw thay ddi ma khéng can théng bao trwde. Truy cap www.philips.com/
support dé tai vé& phién ban t& roi méi nhét.



www.epeat.net
www.epeat.net
www.philips.com/support
www.philips.com/support

4.1 Ché dd dd phan giai & cai
dat san
El D6 phan giai t6i da
1920x1080@60 Hz (dau vao analog)
1920x1080@60 Hz (dau vao KTS)

E1 D6 phan giai khuyén dung
1920x1080@60 Hz (d4u vao KTS)

31,47 720 x 400 70,09
31,47 640 x 480 59,94
35,00 640 x 480 66,67
37,86 640 x 480 72,81
37,50 640 x 480 75,00
37,88 800 x 600 60,32
46,88 800 x 600 75,00
48,36 1024 x 768 60,00
60,02 1024 x 768 75,03
63,89 1280 x 1024 60,02
79,98 1280 x 1024 75,03
55,94 1440 x 900 59,89
70,64 1440 x 900 74,98
65,29 1680 x 1050 59,95
67,50 1920 x 1080 60,00

€ Ghichu

Lwu y rang man hinh cla ban hoat

dong tbt nhat & d6 phan giai goc
1920%x1080@60Hz. D& c6 chat lwgng hién
thi tt nhat, hay dung d6 phan giai khuyén
nghi nay.
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5. Quan ly ngudn dién

Néu ban da cai dat card man hinh hay
phan mém twong thich chudn VESA DPM
vao PC, man hinh c6 thé tw déng giam
tiéu thu dién khi khéng sr dung. Néu phat
hién nhap tr ban phim, chudt hay thiét bi
nhap khac, man hinh sé "hoat déng" tw
doéng. Bang sau day sé hién thi mdoe tiéu
thu dién va cach truyén tin hiéu cla tinh
nang tiét kiem dién tw dong nay:

227E4LSB:

Chédo |, Pdng | Ngudn dién s&v | Mau den
VEsA |Video| B |y sqoel T dung LED
ngang
Hoat dong| BAT | Co C6 [19,2W (chudn)| Tréng
’ Tréng
Ngu TAT |Khéng|Khdng| 0,5W (chudn) | (Nhap
nhay)
Tt TAT | - - | 03W (chuan) | TAT
227E4LHAB:

227E4QSD:
P PoNg | Ax PO L
VESA ngahg b6 doc dung LED
£ oan PoNg | ~x N L
Che do . Dong | Nguon dién st | Mau den z
Video | bd " o . .| 19,2 W (chuan) P
VESA ngang b6 doc dung LED Hoat dong| BAT Co Co 27.9 W (t6i da) Trang
Hoat dong| BAT | Co Co6 |30,7W (chuan)| Tréng Tréng
5 Ngu TAT |Khéng|Khdng| 0,5W (chudn) | (Nhap
. g || MEIE nhay)
Ngu TAT |Khong [Khéng| 0,5 W (chuén) (Nhap - - -
nhay) Tat TAT - - 0,3 W (chuén) TAT
Tat | TAT | - - | 03W (chuin) | TAT
227E4LHSB:
N ideo| bd N
£ A PoNg | pa Ao s VESA b6 doc dung LED
Ché do Video | b Dong | Nguon dién st | Mau den ngang
ViEA ngang belceg Gl LD Hoat dong| BAT | C6 Co6 [19,2W (chudn)| Tréng
Hoat dong| BAT | Co Cé |[32,1W (chuan)| Tréng ’ Tréng
5 Ngu TAT |Khéng|Khdng| 0,5W (chudn) | (Nhap
. g || MEIE nhay)
Ngu TAT |Khong [Khéng| 0,5 W (chuan) (Nhap - - -
nhay) Tat TAT - - 0,3 W (chuén) TAT
Tét TAT | - - | 0,3W (chuan) | TAT o R . . ]
Cai dat sau day dwoc dung dé do murc
227E4QHSD: tiéu thu dién trén man hinh.
3 ° A 2. 0,
Ché a0 |\/4e0 Dggg Dbdng | Ngudn dién s | Mau den B0 twong phan: 50%
VESA nga.ng b6 doc dung LED . D(‘j séng: 250 nit
B “n ~ ~ . y . R by
Hoat agng| BAT | Co | co |31 \O/V((fgiugg)) Tréng . Nblet do mau: 6500k v&i kiéu mau
: trang day du
) Tréng
Ngu TAT [Khéng|Khéng| 0,5W (chudn) | (Nhap e Ghi chu
nhay) " ea N . 2 s .
" - ~ - D liéu nay chiu siw thay doi ma khéng
Tat TAT - - 0,3 W (chuan) TAT P\ N . .
can théng bao trudce.
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6. Théng tin quy dinh

Lead-free Product

Lead free display promotes
environmentally sound recovery
and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community's
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

Congratulations!

This display is designed for both you and the
planet

The display you have just purchased

carries the TCO Certified label.

This ensures that your display is
designed, manufactured and tested according to
some of the strictest quality and environmental
requirements in the world. This makes for a high
performance product, designed with the user
in focus that also minimizes the impact on the
climate and our natural environment.

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO
Certified represents one of the toughest
certifications for displays worldwide.

For displays with glossy bezels the user should
consider the placement of the display as the
bezel may cause disturbing reflections from
surrounding light and bright surfaces.

Some of the Usability features of the TCO
Certified for displays:

*  Visual ergonomics for good image quality
is tested to ensure top performance and
reduce sight and strain problems. Important
parameters are luminance, contrast,
resolution, black level, gamma curve, colour
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and luminance uniformity and colour
rendering.

*  Products are tested according to rigorous
safety standards at impartial laboratories.

*  Electric and magnetic fields emissions as
low as normal household background
levels.

* Low acoustic noise emissions (when
applicable).

Some of the Environmental features of the
TCO Certified for displays:

* The brand owner demonstrates corporate
social responsibility and has a certified
environmental management system (EMAS
or ISO 14001).

* Very low energy consumption both in on-
and standby mode minimize climate impact.

e Restrictions on chlorinated and brominated
flame retardants, plasticizers, plastics and
heavy metals such as cadmium, mercury
and lead (RoHS compliance).

* Both product and product packaging is
prepared for recycling.

*  The brand owner offers take-back options.

The requirements can be downloaded from our
web site. The requirements included in this label
have been developed by TCO Development in
co-operation with scientists, experts, users as
well as manufacturers all over the world. Since
the end of the 1980s TCO has been involved

in influencing the development of IT equipment
in a more user-friendly direction. Our labeling
system started with displays in 1992 and is

now requested by users and [T-manufacturers
all over the world. About 50% of all displays
worldwide are TCO certified.

For more information, please visit:
www.tcodevelopment.com

TCOF1058 TCO Document, Ver. 2.1

[}

GERTIFIED

Technology for you and the planet


www.tcodevelopment.com

EPEAT

(www.epeat.net)

(%  The EPEAT (Electronic
Qe' Product Environmental
7 Assessment Tool) program
evaluates computer

desktops, laptops, and monitors based on 51
environmental criteria developed through
an extensive stakeholder consensus process
supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT’S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.
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CE Declaration of Conformity

This product is in conformity with the following
standards

*  EN60950-1:2006+A11:2009+A1:
2010+A12:2011 (Safety requirement of
Information Technology Equipment).

»  EN55022:2010(Radio Disturbance
requirement of Information Technology
Equipment).

* EN55024:2010 (Immunity requirement of
Information Technology Equipment).

»  EN61000-3-2:2006+A1:2009+A2:2009
(Limits for Harmonic Current Emission).

*  EN61000-3-3:2008 (Limitation of Voltage
Fluctuation and Flicker) following provisions
of directives applicable.

* 2006/95/EC (Low Voltage Directive).

* 2004/108/EC (EMC Directive).

»  2009/125/EC (ErP Directive, EC No.
1275/2008 Implementing Directive
for Standby and Off mode power
consumption)

And is produced by a manufacturing

organization on ISO9000 level.

*  1SO9241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

*  GS EK1-2000:2011 (GS mark requirement).

* prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

*  MPR-II (MPR:1990:8/1990:10 Low
Frequency Electric and Magnetic fields).

¢ TCO CERTIFIED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions.


www.epeat.net

Energy Star Declaration

(www.energystar.gov)

As an ENERGY STAR® Partner, we
have determined that this product

meets the ENERGY STAR®
guidelines for energy efficiency.

i)

& Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission (FCC)
Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.

This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

»  Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced
radio/TV technician for help.
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@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.

Commission Federale de la Communication
(FCC Declaration)

& Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de
I'article 15 Des regles de la FCC. Ces
limites sont concues de facon a fourir
une protection raisonnable contre les
interférences nuisibles dans le cadre d'une
installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.


www.energystar.gov

Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une
installation particuliére. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, |'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer I'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteur.

*  Brancher I'équipement sur un autre circuit
que celui utilisé par le récepteur

¢ Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiére de conformité est susceptible
d'interdire a l'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.

27

EN 55022 Compliance (Czech Republic Only)

Polish Center for Testing and Certification
Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer, and so on)
should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/1T-42107
and PN-89/E-06251.



North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILG/ANGELIGE.

Paikka/llmankierto

VAROITUS:

SIJOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR

ST@MTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
HAZHERERZIEE |

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schiden durch Rontgenstrahlen” festgelegten
Vorschriften.

Auf der Rickwand des Gerites befindet sich

ein Aufkleber; der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Storstrahlern nach Anlage
llla 5 Abs. 4 der Rontgenverordnung erfillt sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, dal3

1. Reparaturen nur durch Fachpersonal
durchgefiihrt werden.
2. nur original-Ersatzteile verwendet werden.

bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf]
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhohte Augenbelastung bei zu
geringem Zeichenkontrast wéren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt 70dB (A) oder
weniger.

) ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.



China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.

hE A ERoHS

REFEAR (BT EEFABMEREENE) (B#APEARRHS) +
PAFRSFH T A QPR R SNE B E RS AN RIS R

REBEAZR
BRE (EARCRT)

LELEEYENTE
B £ TR HELRPHATE
0 3 i ki ERBE | SRoER
(Pb) (Hg) (Cd) (Cr6+) (PBB) (PBDE)
S (o] [e] [e] (o] Q [e]
CRTETA x ] [¢] [e) [¢] [e)
ARG TRE/ITE X [¢] 6] [e) [¢] [®)
| R A ® 9] o [¢) ] )
|RRERSE | x (o] s} [¢) [¢] )
(RBH/EHSE | x [o] [¢] [s] @] o]
* 1 BEISIA B ED R BB « IR - BB - Sk SRS
O FTEH WA TR E L SRS RS B
SRR P B R
X ETEAEARYEEDERAANE SR EE A R
LT EEEE A HERERSHT X W
HEMERHSHEAER (T BRODS)

PRERAL IR

SEAR PR IR (CH4) , 7 B P S I
A H Y REICR AL F A M4 AR KA
SRt R, AL T I TR
P AN SR A i " S RO N B
7 R A KR

FRERE RN RER
AEFEARE (RENEFRNEE) SETHRAUTESR

FIANEE L NEAPRERTIERM « haptww endgyiabel oy o

CRFT LA 17 Bh PO BAT B4 B ) Stk
]

N T UG S R B, 2 AN T
it B i A i AL N, RS IR SR A L g L T
oot (A Ak PR SC i i b, g AT S i LA [ 5
WNRTTR PSR BE B S 1) R AT (P14 B
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EU Energy Label

The European Energy Label informs you on

the energy efficiency class of this product.

The greener the energy efficiency class of this
product is the lower the energy it consumes. On
the label, you can find the energy efficiency class,
the average power consumption of this product
in use and the average energy consumption for
1 yean

&Note

The EU Energy Label will be ONLY applied on
the models bundling with HDMI and TV tuners.



7. Dich vu cham séc
khach hang va bao
hanh

7.1 Chinh sach 16i diém anh man
hinh phang cua Philips

Philips c¢b géng cung cép cac san phdm
chat lwvgng cao nhat. Chung t6i ap dung
moét s6 quy trinh san xuat tién tién nhat,
trong linh vwe va thwe hién quy trinh kiém
tra chat lyong nghiém ngat. Tuy nhién,
cac I6i diém anh hay diém anh con trén
man hinh TFT dung trong cac man hinh
phang ddi khi khong the tranh khoi. Khong
nha san xuat nao coé thé dam bao rang
moi man hinh s& khong c6 cac 16 diém
anh, nhwng Philips dam bao rang bat ky
man hinh nao cé moét sé 16i khong thé
chap nhan sé dwoc stra chira hodc thay
m¢&i dwa vao chinh sach bao hanh. Thong
bao nay giai thich nhitng kiéu 18i dlem anh
khac nhau va dinh nghta cac mic, 16i co
thé& chap nhan cho méi kiéu 16i. Dé hwéng
dich vy stra chira hay thay_ thé theo chinh
sach bao hanh, sé lwong 18i diém anh trén
man hinh TFT phal vuot qua cac mirc
chép nhan nay. Vi dy, khong qua 0,0004%
diém anh con trén man hinh co thé bij 16i.
Ngoai ra, Philips tham con dat ra cac tiéu
chuan chat lwvong cao hon cho mot sb
kiéu hay két hop 16i diém &nh vén dé nhin
thay hon cac kiéu 16i khac. Chinh sach
nay cé hiéu luc trén toan cau.

diém anh con

m \
Piém

anh

Diém anh va diém anh con
Diém anh hay phan t&r anh gdm ba diém
anh con ‘trongxcéc mau chinh dd, luc va
lam. Nhiéu diém anh cuing tao thanh hinh
anh. Khi moi diém anh con ctia mot diém
anh sang Ién, ba diém anh con c6 mau
sac cung hién thi nhw mot diém anh trang
don 1&. Khi moi diém anh con tdi m&, ba
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diém anh con c6 mau séc cung hién thi
nhw mot diém anh den don Ig. Nhirng, két
hop diém anh_con sang va tbi khac hién
thi nhw cac diém anh don 1 tir nhitng
mau khac.

Cac kiéu 16i diém anh
Céc 16i diém anh va diém anh con hién
thi trén man hinh theo nhitng cach khac

nhau C6 hai kiéu 16i diém anh va nhiéu 16i
diém anh con trong méi kiéu I6i.

Cac 16i cham sang

Céc 16i chdm séang hién thi dwdi dang cac
diém anh hay diém &nh con vén luén sang
hay "bat". Nghia la mdi cham sang la mét
diém anh con von ndi I&n trén man hinh
khi man hinh hién thj kiéu hinh t6i mo. Co
cac kiéu 16i cham sang.

Mot diém anh con sang dd, luc hay lam.

| ¢

Hai diém anh con sang gan nhau:

- Do+ Lam=Tim

- Do + Luc = Vang

- Luc + Lam = Lyc lam (Lam nhat)

Ba diém anh con sang gan nhau (mét
diém &nh tréng).



& Ghichu

Chéam sang dé hay lam phéi sang hon
50% so v&i cac chAm xung quanh trong
khi chAm sang luc sang hon 30% so Voi
cac cham xung quanh.

Cac 16i cham den

Céc I18i cham den hién thj dwdi dang cac
diém anh hay diém anh con vén luén téi
md hay 'tat'. Nghia 1a méi chdm téi mo |a
mdt diém anh con vén ndi 1én trén man

hinh khi man hinh hién thj kiéu hinh sang.

C6 cac kiéu 16i cham den.

LOI CHAM SANG

D6 gan cua cac 16i diém anh

Vi cac 16i diém anh va diém anh con clta
cung kiéu 16 vén gan véi mot kiéu 16i khac
c6 thé dé nhin thay hon, Philips ciing néu
ré cac dung sai vé do gan cda I6i diém
anh.

Dung sai 16i diém anh

D& hwéng dich vu stra chiva hay thay

thé do cac 16i diém anh trong thoi han

bdo hanh, man hinh TFT trong man hinh
phéng Philips phai ¢ cac 16i diém anh hay
diém anh con vwot qua nhitng dung sai
néu trong cac bang sau.

MUC CHAP NHAN

1 diém anh con sang 3

2 diém anh con sang gan nhau 1

3 diém anh con sang gan nhau (mét diém anh tréng) 0
Khoang cach gitra hai I6i chdm sang* >15mm
Tbng sb 16i chAm sang ctia moi kiéu 16i 3

LOI CHAM BEN MUC CHAP NHAN
1 diém anh con t6i m& 5 hodc it hon
2 diém anh con tbi m¢& gan nhau 2 hoac it hon
3 diém anh con t6i m& gan nhau 0
Khodng cach gitva hai I6i chAm den* >15mm
T6ng s6 16i chdm den clia moi kiéu I5i 5 hosc it hon

TONG SO LOI CHAM

Téng s 16i cham sang hay den ctia moi kiéu 16

MUC CHAP NHAN
5 hoac it hon

& Ghi chu

1. 1 hay 2 16i diém anh con gan nhau = 1 16i chdm

2. Man hinh nay tuan tha chuan 1ISO 9241-307. (1S09241-307: Yéu cu, phan tich vé hiéu
nang va cac phwong phép kiém tra tuan thd cho man hinh dién ti)



7.2 Cham séc khach hang & Ché dé bao hanh

D& c6 thdng tin chi tiét vé chinh sach bdo hanh va yéu cau hd tro thém dwoc ap dung cho
khu vic clia ban, vui long truy cap website www.philips.com/support. Ban ciing cé thé lién
hé vé&i Trung tdm cham séc khach hang dia phwong ctia Philips theo sé dién thoai dwéi
day.

Théng tin lién lac cho khu vwe TAY AU:

ASC (Trung tam dich S6 cham séc khach hang Gia

Quéc gia

vu Uy quyén)

Germany Siemens I1&S +49 01803 386 853 €0,09
United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
Ireland Invec Scotland +353 01 601 1161 Local call tariff
Spain Eatsa Spain +34 902 888 785 €0,10
Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 €0,09
Greece Allman Hellas +30 00800 3122 1223 Free of charge
Italy A-novo +39 840 320 041 €0,08
Netherlands E Care +31 0900 0400 063 €0,10
Denmark A-novo +45 3525 8761 Local call tariff
Norway A-novo +47 2270 8250 Local call tariff
Sweden A-novo +46 08 632 0016 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Austria Siemens 1&S +43 0810 000206 €0,07
Belgium E Care +32 078 250851 €0,06
Luxembourg E Care +352 26 84 30 00 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
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www.philips.com/support

Thong tin lién lac cho khu viec TRUNG VA BONG AU:

Trung tam

ASC (Trung tam dich vu ay

Quéc gia

dich vu

quyen)

S6 chiam séc khach hang

Belarus NA IBA +375 17 217 3386
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA Renoprom +385 1 333 0974
Estonia NA FUJITSU +372 6519900
Latvia NA “ServiceNet LV” Ltd. +371 7460399
Lithuania NA UAB “Servicenet” +370 7400088
Romania NA Blue Ridge Intl. +40 21 2101969
fﬂiﬁ’t‘;‘nigm NA Kim Tec d.0.0. +381 11 20 70 684
Slovenia NA PC H.and +386 1 530 08 24
Uil NA Comel +380 562320045
NA Topaz-Service Company +38 044 245 73 31
Russia NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)
Slovakia NA Datalan Service +421 2 49207155
Turkey NA Techpro +90 212 444 4 832
Czech Rep. |NA Asupport 800 100 697
NA Serware +36 1 2426331
Hungary - -
NA Profi Service +36 1 814 8080

Théng tin lién lac cho khu viec CHAU MY LATINH:

Quéc gia

Brazil

Argentina

Trung tam dich vu

Vermont

S6 cham séc khach hang
0800-7254101

0800 3330 856

Théng tin lién lac & Trung Quéc:

Trung Quéc

Sé cham séc khach hang: 4008 800 008

Théng tin lién lac cho khu viec NAM MY:

Quéc gia

Trung tam

ASC (Trung tam dich vu uy

S6 cham séc khach hang

U.S.A.

dich vu
EPI - e-center

quyén)
Qwantech

(877) 835-1838

Canada

Supercom

Supercom

(800) 479-6696
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Théng tin lién lac cho khu vuc Chau A TBD/Trung Dong/Chau Phi (APMEA):

Quéc gia Trung tam ASC (Trung tam dich vu ay S6 chiam séc
9 dich vu quyén) khach hang
Australia NA AGOS NETWORK PTY LTD 1300 360 386
New Zealand NA Visual Group Ltd. 0800 657447
3 Kong Tel: +852
Hong Kong / Macau | NA Smart Pixels Technology Ltd. %/I6a10au Tel: (853)-
0800-987
Tel: 1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS to
56677
Indonesia NA PT. Gadingsari elektronika Prima ;2585025237?59?3358
South Korea NA PCS One Korea Ltd. 080-600-6600
Malaysia NA éLtgr Market Solutions (CE) Sdn 603 7953 3370
Pakistan NA Philips Consumer Service (9221) 2737411-16
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer Care (65) 6882 3999
Center)
PCCW
Taiwan Teleservices |FETEC.CO 0800-231-099
Taiwan
Thailand NA Axis Computer System Co., Ltd. (662) 934-5498
South Africa NA Sylvara Technologies Pty Ltd 086 0000 888
United Arab
Emirates NA AL SHAHD COMPUTER L.L.C 00971 4 2276525
Israel NA Eastronics LTD 1-800-567000
+84 8 38248007 Ho
S 754 5115365666
- ervice Informatic Company |+ .
i - Ltd. Danang Cit
+84 5113.562666
Can tho Province
Philippines NA Glee Electronics, Inc. Egg; 8334533 to 34,
. no distributor and/or service
Sri Lanka NA provider currently
ot 880-2-9141747
Distributor: Computer Source Ltd ’
Bangladesh NA 9127592
(watranty buysout) 880-2-8128848 / 52
Distributor: Syakar Co. Ltd
Nepal NA (warranty buy-out) 977-1-4222395
; Distributor: Neat Technology Pte
Gl b Ltd (Singapore) ( warranty%uy-out) e
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8. Khac phuc sw co &
Hoi Dap

8.1 Khac phuc sw cb

Trang nay giai quyét cac sw ¢ vén nguoi
diing c6 thé khc phuc. Néu sw cb van
tiép di&n sau khi ban da thr dung cac giai
phéap trén trang nay, hay lién hé véi dai
dién dich vy khach hang cta Philips.

El Cac sw cb thwong gap

Khéng c6 hinh anh (Pén LED ngudén

khéng sang)

+ Dam bao da cam day ngudn vao 6
cam dién va mat sau ctia man hinh.

+  Trwoc tién, ddm bao nut ngudn &
mat trwéc man hinh nam & vj tri OFF
(TAT), sau d6 day nat sang vi tri ON
(BAT).

Khéng c6 hinh anh (Pén LED nguén

sang trang)

*  Dam bao da bat may tinh.

«  DPam bao cap tin hiéu da dwoc két ndi
duang céach véi may tinh clia ban.

+ Dam bao cap man hinh khéng cé cac
ch’éu cam bj cong trén mat két noi.
Néu co, hay stra hay thay méi cap.

« C6 thé da bat tinh nang Tiét kiém
nang lvong

Man hinh thong bao

Attention

Check cable connection

« Dam bao cap man hinh da dwoc két
ndi ding cach véi may tinh cla ban.
(Cting tham khao Huéng dan khéi
déng nhanh).
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+  Kiém tra xem cap man hinh cé cac
chau cam bi cong hay khéng.

*  Dam bao da bat may tinh.

Nut AUTO (Tw dong) khéng hoat dong

« Chlrc néng tw dong chi ap dung & ché
dd VGA- Analog. Néu khong hai long
v&i két qua, ban co thé thwe hién cac
diéu chinh thd cong qua menu OSD
(hién thi trén man hinh).

& Ghicha

Chirc nang Auto (Tw déng) khong ap

dung & ché do DIV-Digital (DVI-KTS) vi n6

khoéng can thiét.

Cac dau hiéu vé khéi hay tia Itra c6 thé

nhin thay

+ Khong thyc hién bat ky buoc khac
phuc s cO nao

« Ngét ngay két néi man hinh khéi 6
cam dién chinh cho an toan

» Lién hé ngay v&i dai dién dich vu
khach hang cua Philips.

B Cac sw c6 hinh anh

Hinh anh khéng nam giiva tam man hinh

« Chinh vj tri hinh &nh qua chlrc nang
“Auto” (Tw doéng) trong cac nut didu
khién chinh trén menu OSD.

« Chinh vj tri hinh &nh qua Phase/Clock
(Géc pha/bdng hd) cla Setup (Cai
dat) trong cac nut diéu khién chinh
trén menu OSD. N6 chi co hiéu lwc &
ché do VGA.

Hinh anh rung lén trén man hinh

. K[ém tra xem cap tin hiéu da dwoc
cam chat dung cach vao bang mach
do hoa hay may tinh hay chua.

Hién thij hién twong chap chon doc



«  Chinh hinh anh qua ch&c nang “Auto
(Tw déng)” trong cac nuat diéu khién
chinh ctia menu OSD.

* Loai bé céac vach doc qua Phase/
Clock (Géc pha/bBéng hd) clia Setup
(Cai d&t) trong cac nat diéu khién
chinh ctia menu OSD. N6 chi co hiéu
lwc & ché do VGA.

Hién thi hién twong chap chen ngang

* Chinh hinh anh qua chirc nang “Auto
(Tw doéng)” trong cac nuat diéu khién
chinh ctia menu OSD.

» Loai bd céac vach doc qua Phase/
Clock (Géc pha/Ddng hd) cliia Setup
(Cai dat) trong cac nut diéu khién
chinh ctia menu OSD. N6 chi co hiéu
lwc & ché do VGA.

Hinh anh hién thi nhoe, khong ré hoac
qua m&

* Chinh d6 twong phan va do sang trén
menu Hién thj trén man hinh (OSD).

» o«

Hién twong “anh ao”, “anh thir néng”
hay “anh béng ma” van hién thj sau khi
da tat nguén.

+ Hién thi lién tuc cac anh tinh trong mot
thoi gian dai c6 thé gay ra hién twong
“anh thir néng”, con dwoc goi la “anh
ao” hay “anh béng ma”, trén man hinh
cta ban. “Anh thir néng”, “Anh a0”
hay “Anh béng ma” Ia hién twong phd
bién trong cong ngh& man hinh LCD.
Trong hau hét cac trwdng hop, hién
twong “anh thtr nong” hoac “anh ao”
hay “anh béng ma” sé& dan dan bién
mat sau moét thdi gian man hinh bi
ngét dién.

e Ludn béat trinh bdo vé man hinh
chuyé&n ddng khi ban khéng st dung
man hinh.

e Lubn bat (rng dung lam m¢&i man hinh
dinh ky, néu khéng, man hinh LCD
clia ban sé hién thi nhirng ndi dung
tinh khong thay dbi.

«  Khéng thé kich hoat trinh bao vé
man hinh hoac (rng dung nap lai man
hinh dinh ky c6 thé gay ra cac sw cb
nghiém trong nhw “thtr néng” hoac
“anh sau” hodc “anh béng ma” vén
s& khong biét mét va ciing khéng thé
khéc phuc. Thiét hai nhw trén khong
nam trong chinh sach bao hanh cla
chung toi.

Hinh hién thi bién dang. Van ban bi m&

hoac nhoe.

+ Cai do phan gidi man hinh may tinh
sang cung ché do v&i d6 phan giai
man hinh gbc khuyén diing ctia man
hinh LCD.

Cac cham luc, d6, lam, den va trang

hién thi trén man hinh

« Cac cham con lai la dc tinh thong
thwéng clia man hinh tinh thé 1dng
dung trong cong nghé ngay nay. Vui
long tham khao chinh sach diém anh
dé biét thém thong tin.

Dé'n “bat ngudn” qua sang va gay choi

mat

+ Ban ¢ thé chinh dén “bat nguon” qua
Cai dat dén LED nguon trong cac nut
diéu khién chinh ctia menu OSD.

DPé duwoc tro gitip thém, hay xem danh

sach Trung tdm thong tin khach hang

va lién hé vai dai dién dich vu cham séc

khach hang cta Philips.



8.2 Hoi dap SmartControl Lite

H1. Téi da déi man hinh trén PC sang
man hinh khac va khong thé st
dung SmartControl, t6i can lam gi?

Pap: Hay khéi dong lai PC va kiém tra
xem SmartControl Lite cé hoat dong
khong. Néu khong, ban can phai g&
bo va cai dat lai SmartControl Lite dé
dam bdo cai dat driver thich horp.

H2. Cac chirc nang SmartControl Lite
da hoat dong t6t trwwéc d6, nhung
gio’ n6 khong hoat dong niva, toi
c6 thé lam gi?

Pap: Néu da thwc hién cac thao tac sau,
thi ban can phai cai dat lai driver man
hinh.

« D3 ddi bo thich &ng dd hoa video

sang moét adapter khac

* Da cap nhat driver video

» Cac hoat dong trén HDH nhuw géi hoac
loat vyng dung

* Chay Céap nhat Windows va cap nhat
man hinh va/’hoac driver video

+ Da khéi dong Windows bang nut tat
hay ngat két néi man hinh.

«  Dé xac dinh sy ¢b, hay click chudt
phadi My Computer (May tinh cua t6i)
va click vao Properties (Thuéc tinh)-
>Hardware (Phan cirng)-> Device
Manager (Quan ly thiét bj).

* Néu nhin thay “Plug and Play Monitor’
(Man hinh cdm vao 1a chay) hién
thi trong Monitor (Man hinh), thi
ban can cai dat lai. Chi can g& bd
SmartControl Lite va cai dat lai.

H3. Sau khi cai dat SmartControl Lite,
khi click vao thé SmartControl
Lite, khong c6 muc nao bat Ién
sau moét lat hoac thong bao 16i
hién thi, diéu gi da xay ra?

Pap: Cé thé Ia do bo thich trng dd hoa cla
ban khdng twong thich véi t'ng dung
SmartControl Lite. Néu b thich rng

dd hoa la moét trong sé cac nguyén
nhan néu trén, thir tai v& driver bd
thich (rng d6 hoa mé&i nhét tir website
clia cac cong ty twong trng.

Cai dat driver. G6 bé SmartControl
Lite va cai dat lai mot 1an niva.

Néu né van khong hoat dong, thi

rét tiéc 12 bd twong (rng dd hoa
khéng dwoc hd tro. Vui long truy cap
website ctia Philips va kiém tra xem
driver SmartControl Lite m¢i nhat da
c6 sén hay chua.

H4. Khi t6i click vao Product Information
(Théng tin san pham), né chi hién
thi mét phén, diéu gi da xay ra?

Pap: Co thé la do driver b thich trng db
hoa cua ban khdong phai la phién
ban cap nhat mai nhat vén hé tro
day da giao dién DDC/CI. Hay thr
tai vé driver bo thich &ng d6 hoa
m&i nhét tlr website clia cac cong
ty twong (rng. Cai dat driver. G6 bd
SmartControl Lite va cai dat lai mot
I&n nira.

Attention

Theft mode enabled

H5. Toi da quén ma PIN cho chirc
niang Theft Deterrence (Chéng
trdm). Toi can lam gi?

Pap: Trung tam dich vu Philips c6 quyén
yéu cau xac nhan va quyén hop &
dé thiét 1ap quyén s& hiru man hinh.
Xin lwu y chire ndng chéng trom
dwoc cung cap nhu 13 tiy chon tién
ich mi&n phi. Quan Iy ma PIN 1a
trach nhiém riéng cda nguwdi dung
ca nhan hay té chirc vén dé tao ra
ma nay. Trong trw&'ng hop quén ma
PIN, trung tam dich vu Philips c6 thé
tao lai cho ban v&i mire phi nhé sau
khi xac nhan quyén sé& hiru cia ban.
Xin lwu y chirc nang nay khdong dwoc
bao gém trong cac diéu khoan bao
hanh chinh thirc.




8.3 Héi bap chung

H1: Khi cai cai dat man hinh, t6i cin lam
gi néu man hinh hién thj "Cannot
display this video mode" (Khong
thé hién thi ché do video nay)?

Pap: Do phan giai khuyén dung cho man
hinh nay la: 1920x1080@60Hz

« Ngét tat ca cac cap roi két néi PC voi

man hinh ma ban da dung trwéc dé.

* Trong Windows Start Menu (Menu

kh&i dong Windows), chon Settings/
Control Panel (Cai dat/bang dieu
khién). Trong Control Panel Window
(Ctra sb bang diéu khién), chon biéu
twgng Display (Man hinh). Bén trong
Display Control Panel (Bang diéu
khién man hinh), chon thé "Settings"
(Cai dat). Trong thé cai dat, trong 6
co tén 'desktop area' (vung man hinh
nén), chuyén thanh trwot sang mirc
1920%x1080 pixels.

* M& thé "Advanced Properties" (Thudc
tinh ndng cao) va cai Refresh Rate
(Mtrc nap lai) sang 60Hz rdi click vao
OK.

+ Khai dong lai may tinh va lap lai
buwéc 2 va 3 dé kidm tra xem PC
clia ban da dwoc cai sang mirc
1920%1080@60Hz hay chua.

+  Tat may tinh, ngat két n6i man hinh
cl va két ndi lai man hinh LCD Philips
cua ban.

« Tt man hinh rdi bat lai PC.

H2: Mdrc cép nhéat khuyén dung cho
man hinh LCD la bao nhiéu?

Dap: Mirc cap nhat khuyén dung cho man
hinh LCD la 60Hz; néu c6 béat c»
hién twong nhiéu nao trén man hinh,
ban c6 thé cai dat mrc nay sang
75Hz dé kiém tra xem mirc méi nay
c6 loai bé duwoc hién twong nhiéu
hay khoéng.
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H3: Cac file .inf va .icm trén dia CD
1a gi? Lam thé nao dé cai dit cac
driver (.inf va .icm)?

Dap:Day la cac file driver cho man hinh
cla ban. Thuc hién theo cac chi dan
trong s tay str dung dé cai d&t cac
driver nay. May tinh c6 thé yéu cau
ban cai cac driver man hinh (file .inf
va .icm) hodc Iap dia driver khi ban
cai d&t man hinh 14n dau. Thyc hién
theo cac chi dan dé I&p (dia CD kém
theo) thung dwng man hinh nay. Cac
driver man hinh (file .inf va .icm) sé
duwoc cai dat ty dong.

H4:
Pap:

Lam thé nao dé chinh do6 phan giai?
Card video/driver db hoa cla ban

va man hinh sé ciing quyét dinh

cac do phan giai c6 san. Ban c6 thé
chon d6 phan giai mong muén trong
Control Panel (Bang diéu khién)

cta Windows® qua thé “Display
properties (Thudc tinh man hinh)”.

H5: Diéu gi sé xay ra néu téi quén cac
thao tac tiép theo khi dang diéu
chinh man hinh qua menu OSD?
Chi can nhan nuat OK, rdi chon 'Reset'
(Cai dat lai) dé cai dat tAt ca tré vé
cai dat mac dinh gdc.

bap:

H6: Man hinh LCD c6 kha niang chéng
tray xwérc?

N6i chung ban khéng nén dé& bé mat
man hinh va cham qua muc véi cac
vat khac hay va bao vé né khoi cac
vat dung sac hay cun. Khi cAm man
hinh, d@m bao khong dung strc ép
hay Iwc manh 1én phia bé& mat man
hinh. Diéu nay cé thé anh hwéng dén
cac diéu kién bao hanh cla ban.

Dap:

T6i nén lau man hinh LCD nhw thé
nao?

DPap: Dé lau théng thweng, hay st dung
khan sach va mém. D& lau k¥, hay
duing cdn isopropyl. Khéng diing

cac dung méi khac nhw cdn étylic,
ethanol, axeton, hexan, v.v...

H7:



H8: Toi co thé thay déi cai dat mau sic

cho man hinh?

Pap: Di nhién, ban c6 thé thay dbi cai

dat mau sic qua nuat didu khién trén
menu OSD theo cac quy trinh sau,

« Nhan “OK” dé hién thi menu OSD
(Hién thi trén man hinh)

«  Nhén "Down Arrow" (Mdii t&n xuéng)
d& chon tty chon "Color" (Mau) rdi
nhén "OK" dé vao cai d&t mau; cé ba
Iwa chon mau nhw sau.

1. Color Temperature (Nhiét d6 mau):
v&i cac cai dat trong pham vi
6500K, man hinh sé hién thi “néng,
vé&i tin hiéu mau dé-trdng"”, trong
khi nhiét d6 9300K tao ra “tin hiéu
mat lam-trng”.

2. sRGB (Pé-Luc-Lam chuén): day
la cai dat chuan dé dam bao trao
ddi mau thich hop gitra cac thiét bi
khac nhau (vd: may anh KTS, man
hinh, may in, may quét, v.v...)

3. User Define (Tw chon): ngwoi dung
cé thé tw chon cai dat mau sac wu
tién bang cach chinh mau da, luc
va lam.

& Ghichu

Do mau anh sang téa ra tir mot vat dung
trong khi n6 dwoc 1am néng. S6 do nay
dwoc thé hién dwa trén ty lé tuyét dbi, (mirc
dd Kelvin). Cac mirc nhiét d6 Kevin thap
hon nhw 2004K |a mau doé; cac mire nhiét
d6 cao hon nhw 9300K Ia mau lam. Nhiét
dé trung tinh 1a mau trdng & mirc 6504K.

H9: Tai c6 thé két néi man hinh LCD véi
moi PC, may chua hay may Mac?

Co thé. T4t ca cac man hinh LCD
Philips déu hoan toan twong thich
véi cac PC, may Mac va may cha
chuan. Ban c6 thé can co dau noi
cap dé két néi man hinh méi hé
théng may Mac. Vui long lién hé véi
nhan vién kinh doanh ctia Philips dé
biét thém théng tin.

bap:
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H10: Man hinh LCD Philips ¢é6 hé tro
chuén Plug-and-Play (Cam vao la
phat)?

C6, cac man hinh Philips d&u hé tro
chuan Plug-and-Play twong thich véi
Windows 7/Vista/XP/NT, Mac OSX,
Linux

bap:

H11: Anh chap chon hay anh thir néng
hay anh ao hay anh béng ma trén
man hinh LCD la gi?

Hié&n thi lién tuc cac anh tinh trong
mot thoi gian dai ¢é thé gay ra hién
twong "anh th&r ndng", con dwoc goi
la “Anh d0” hay “dnh béng ma”, trén
man hinh ctia ban. “Anh th&r néng”,
“Anh &o0” hay “Anh béng ma” 1a hién
twong phd bién trong cong nghé man
hinh LCD. Trong moi trwdng hop,
hién twgng “anh th&r ndng” hay “adnh
40” hay “anh béng ma” sé bién mét
dan trong moét thdi gian sau khi da tat
ngudn.

Ludn bat trinh bdo vé man hinh
chuyé&n ddng khi ban khéng st dung
man hinh.

Ludn bat (rng dung lam m&i man
hinh dinh ky, néu khéng, man hinh
LCD ctia ban sé hién thi nhitng noi
dung tinh khéng thay ddi.

() Canh bao

Céc hién twong “anh thir nong” hay “anh
40” hay “anh béng ma” sé& khong biét mat
va ban can mang man hinh di stra. Thiét
hai nhw trén khéng nam trong chinh sach
bao hanh cula chung toi.

bap:

H12: Tai sao man hinh cia téi hién thj
vin ban sic nét va cac ky tw ring
cwa?

Pap: Man hinh LCD cta ban hoat
dong tét nhat & dd phan giai gbc
1920%1080@60Hz. D& man hinh
hién thi t&t nhat, vui Iong st dung d6
phan giai nay.
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